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Introduction Notes

To ensure students will get the most out of this class confirm that all the students are

proficient in the basic use of Windows commands and operations. This book does not

cover basic Windows operations. To give the students a better understanding of Autodesk

Inventor's power and capabilities, present to the class the creation of a simple part and

assembly. This will show the students the ease of use and power behind Autodesk

Inventor.

When working through this book each student should work through all of the tutorials

and exercises on their own, this will build proficiency. Each chapter builds on the

previous chapter. As the students complete each tutorial and exercise they should feel
free to experiment with other methods of completing the tutorial and exercise. The
geometry in the first few chapters is simpler in nature to ensure the students understand
the methodology of Autodesk Inventor. As the book progresses, the amount of help given
in the tutorials and exercises will decrease.

- Project files: For this book a simple project file will be used. As an advanced
exercise you may want to have the students do a group project that utilizes the multi-
user environment.

- Application Options: Application Options are explained throughout the book when
a section is introduced. Since there are many options you may want to introduce the
options that are relevant to your students.

- Design Support System: The Design Support System is a powerful tool. Show how
the help system can help the student gain proficiency and work through errors.

- User Interface: The User Interface of Autodesk Inventor was designed to be clean
and easy to use. Introduce the students to the different aspects of the layout including
the Browser, Status Bar, Command Bar, Standard Toolbar, Panel Bar, tool tips, pull

down menus, context menus and graphics window.



Wheel Mouse: Teach the students how the wheel works for zooming and panning. In
Autodesk Inventor the wheel is opposite of AutoCAD.

Units: Autodesk Inventor utilizes true units, it is important that the students
understand how units can be used in different design scenarios. Demonstrate how
millimeters and inch data can be used in a single part.

Sketching: Sketching is the foundation for creating parts, make sure that each student

is proficient in sketching before they proceed onto the next chapter.



Chapter 1
CHECKING YOUR SKILLS

1 Explain the reasons for which a project file is used.
Projects are text files that contain search paths to find files that are needed for a given project. With these
search paths, all the needed files can be located when an assembly, drawing, or presentation file is opened.

2 True___ False___ Only one project can be active at any time.
True

3 List the sequence of the locations searched when a file is opened in Autodesk Inventor.
- Library Path searched, only if'it is a library part
- Workspace
- Local Search Paths in the order listed in the project file
- Workgroup Search Paths in the order listed in the project file

4 True___ False___ Autodesk Inventor stores the part, assembly information, and related drawing views in
the same file.

False, While creating parts, assemblies, presentation files, and drawing views, that data is stored in
separate files with different file extensions.

5 True___ False___ Press and hold down the F4 key to dynamically rotate a part.
True

6 True___ False___ The Save Copy As command saves the active document with a new name and then
makes it current.

False, the Save Copy As command saves the active document with a new name but it does NOT make the
new file active.

7 List four ways to access the Help system.
- Press the F1 key and the Help system gives you help with the operation that is active.
- Click an option on the Help menu.
- Click a Help option on the right side of the Standard toolbar.
- Inany dialog box, click the "?" icon.

8 Explain how to create a shortcut.
1. In the Customize dialog box click in the Shortcut area of the tool that you want to change.
1. On the keyboard, press the key(s) that will be the shortcut. A single letter or number can be used. You can
also use the SHIFT, CTRL, and ALT keys and a letter or number. The ALT key can be combined with the
SHIFT and/or CTRL key(s) and a letter or number. The ALT key CANNOT be used with only a letter.
1. Press ENTER to create the shortcut.

9 True___ False___ The Look At tool changes the viewpoint to an isometric view.
False, The Look At tool changes the viewpoint so you are looking parallel to a plane, or rotates the screen
viewpoint to be horizontal to an edge.

10 True___ False___ You can only edit a part while it is in shaded display.
False, You can choose Shaded Display, Hidden Edge Display, or Wireframe Display mode as you see fit.



Chapter 2
CHECKING YOUR SKILLS

1 True___ False____ When sketching, constraints are not applied to the sketch by default.

False. While sketching, small constraint symbols appear that represent geometric constraint(s) that will be
applied to the object. If you do not want a constraint to be applied, hold down the CTRL key when the point
is selected.

2 True___ False___ When sketching and a point is inferred, a constraint is applied to represent that
relationship.

False, When inferred points are selected, no constraints (geometric rules such as horizontal, vertical,
collinear, etc.) are applied from them. Using inferred points helps create more accurate sketches.

3 True___ False___ A sketch does not need to be fully constrained.

True, Autodesk Inventor does not force you to fully constrain a sketch. It is recommended to fully constrain
a sketch, however, as this will allow you to better predict how a part will react when dimensions values are
changed.

4 True___ False___ When working on a mm part, you cannot use English units.
False, The default unit for any value can be overridden by entering in the desired unit.

5 True___ False___ After a sketch is constrained fully, you cannot change a dimension’s value.
False, To edit a dimension that has already been created, double-click on the value of the dimension and
enter a new value in the Edit Dimension dialog box.

6 True___ False___ A driven dimension is another name for a parametric dimension.

False, A driven dimension is a reference dimension. It is not a parametric dimension it just reflects the size
of the points to which it is dimensioned. A driven dimension will appear with parentheses around the
dimensions value, like (30).

7 If you use the Auto Dimension tool on the first sketch in the part, the sketch will be constrained fully.
False, If you use the Auto Dimension tool on the first sketch in the part, two dimensions or constraints will
be required to fully constrain the sketch. Use the Fix constraint, or constrain or dimension to the projected
origin planes, axis or center point to remove the two required dimensions.

8 True___ False___ You can only import 2D AutoCAD data into Autodesk Inventor.
False, many file types can be imported into Autodesk Inventor, including the following files types;
AutoCAD (2D and 3D), AutoCAD Mechanical, Mechanical Desktop, SAT, STEP, PRO/E, DXF, and IGES.

9 Explain how to draw an arc while still in the Line command.

While using the line tool move the cursor over an endpoint and a small circle will appear at that endpoint.
Click on the small circle, and with the left mouse button pressed down, move the cursor in the direction that
you want the arc to go. Depending upon how you move the mouse, up to eight different arcs can be drawn.

10 Explain how to remove a geometric constraint from a sketch.

Click the Show Constraints tool from the Sketch Panel Bar. Select an object and a row of constraint icons
will appear, move the cursor over a constraint icon, the objects that are linked to that constraint will
change color. Then, either click on it and then right-click, or right-click while the cursor is over the
constraint and select Delete on the menu.

11 Explain how to change a vertical dimension to an aligned dimension while it is being created.

The technique to change the constraint is called scrubbing. To place a different constraint while sketching,
move the cursor so it touches (scrubs) the other object to which the constraint should be related. Move the
cursor back to its original location and the constraint symbol changes to reflect the new constraint.

12 Explain how to create a dimension between two quadrants of two arcs.



Start the General Dimension tool.

Click an arc or circle that includes one of the quadrants to which it will be dimensioned.
Move the cursor over the quadrant of the second arc or circle to which it will be dimensioned.
Move the cursor over the quadrant until the constraint symbol changes to quadrant.

Click and then move the cursor until the dimension is in the correct location, and click.



Chapter 3
CHECKING YOUR SKILLS

1 What is a base feature?
The first sketch of a part that is used to create a 3D feature.

2 True___ False___ When creating a feature with the Extrude or Revolve tool, you can drag the sketch to
define the distance or angle.
True

3 Which objects can be used as an axis of revolution?
A straight edge, centerline, or line can be used as an axis of revolution. The edge does not need to be part
of the sketch.

4 Explain how to create a diametric dimension on a sketch.

Use the General Dimension tool and select either a centerline and the other point or line to be
dimensioned, or click a point or edge and then the centerline. You can also right-click in the graphics
window and select Linear Dimension with the General Dimension tool active.

S Name two ways to edit an existing feature.
1. Right-click or double-click on the feature’s name to edit or perform a function.
1. Right-click and select Edit Feature from the menu.
1. If'the Feature Select tool is active, double-click the feature in the graphics window.
1. Right-click a feature, face, or sketch and click 3D Grips from the menu. Click and drag the grip
that is associated with the geometry that you want to modify.

6 True___ False___ Once a sketch becomes a base feature, you cannot delete or add constraints,
dimensions, or objects to the sketch.
False, you can edit a sketch at any time and modify it or add objects, dimensions, etc. to the sketch.

7 Name three operation types used to create sketched features.
1. Cut
1. Join
1. Intersect

8 True False____ A cut operation cannot be performed before a base feature is created.
True

9 True___ False___ Once a sketched feature exists, its termination cannot be changed.
False, you can edit a sketched feature and modify the termination that is used.

10 True___ False___ Geometry that is projected from one feature to a sketch that defines another feature
will automatically update based on changes to the original projected geometry.
True



Chapter 4
CHECKING YOUR SKILLS

1 True False____ When creating a fillet feature that has more than one selection set, each selection set is
displayed as an individual feature in the Browser.
False. When multiple selection sets exist, they are created as a single fillet feature.

2 In regards to creating a fillet feature, what is a smooth radius transition?
The fillet feature blends from the start to the end radius as a smooth transition, similar to a cubic spline;.
otherwise the fillet blends from the start to the end radius as a straight line.

3 True___ False___ When creating a fillet feature with the All Fillets option, material is removed from all
concave edges.
True

4 True___ False___ When creating a chamfer feature with the Distance and Angle option only one edge
can be chamfered at a time.
False, multiple edges can be selected when using the Distance and Angle option of the Chamfer feature.

5 True False When creating a Hole feature, you do not need to have an active sketch.
True, although you can create a hole feature when a sketch is active, you can also use the Concentric, On
Point, and Linear options to create a hole feature without having a sketch active.

6 For what reason is a hole center used?
Hole Center’s are used to represent the center of the hole(s) that will be placed with the Hole tool when
using the From Sketch option.

7 True___ False___ Thread features are represented graphically on the part and will be annotated correctly
when you generate drawing views.
True

8 True___ False___ A part may contain only one shell feature.
False, you can create multiple shell features in a part.

9 When you are creating a face draft feature, what is the definition of pull direction?
The pull direction is used to specify how the mold will be pulled from the part. The angle of the face draft
feature expands in this direction.

10 True___ False___ The only method to create a work axis is by clicking a cylindrical face.
False, some additional methods to create a work axis besides a cylindrical face are:

1. Two points on a part.

2. An edge of a part.

3. A work point or sketch point and a plane or face.

4.  Two non-parallel planes

11 True___ False___ You need to derive every new sketch from a work plane feature.
False, you can use any planar face or work plane to create a new sketch.

12 Explain the steps to create an offset work plane.
1. Click the Work Plane tool.
2. Click a plane and then drag the new work plane to a selected location.
3. Enter a value in the Offset dialog box to specify the offset distance for the new work plane.
4. Click the check mark in the Offset dialog box or press ENTER on the keyboard.

13 True___ False___ You cannot create work planes from the default work planes.



False, you can reference the default work planes to create any type of work plane that needs a planar face
as input for its definition.

14 True___ False___ When you are creating a rectangular pattern, the directions that the features are
duplicated along must be horizontal and vertical.

False, you can reference any edge to be used as a direction for a rectangular pattern. The edge can be at
an angle, horizontal, vertical, or a spline.

15 True___ False___ When you are creating a circular pattern, you can only use a work axis as the axis of
rotation.
False, you can use any edge, axis or circular face.



Chapter §
CHECKING YOUR SKILLS

1 True___ False_ A drawing can have an unlimited number of sheets.
TRUE. There is no limit to the number of drawing sheets you can have in a drawing.

2 True___ False___ A drawing’s sheet size is normally scaled to fit the size of the drawing views.
FALSE. It is the scale of the drawing views that are normally scaled to fit the drawing sheet size.

3 True___ False___ There can only be one base view per sheet.
FALSE. A number of base views can be created on a single drawing sheet. This is especially useful when
arranging many parts on the same drawing sheet.

4 True___ False___ An isometric view can only be projected from a base view.
FALSE. Isometric views can be projected from any drawing view.

5 True___ False___ Drawing dimensions can parametrically drive dimensional changes back to the part.

FALSE. Drawing reference dimensions cannot parametrically drive dimensional changes back to the part.
Parametric model dimensions displayed in a drawing view can parametrically drive dimensional changes
back to the part.

6 Explain how to shade an isometric drawing view.
Use the following steps to shade an isometric drawing view:
1. Right-click on the isometric view.
2. Select Edit View from the menu.
3. When the Drawing View dialog box appears, click on the Shade button located in the Style area.
4. Click the OK button to dismiss the Drawing View dialog box and shade the isometric drawing
view.

7 True___ False___ When creating a hole note using the Hole/Thread Notes tool, circles that are extruded to create a
hole can be annotated.

TRUE. The Hole/Thread Notes tool will add annotations to holes that were created as extrusions.
However, this tool is most effective when annotating features such as holes, counterbores and countersinks
created with the Hole tool.



Chapter 6
CHECKING YOUR SKILLS

1 True___ False___ The only way an assembly can be created is by placing existing parts into it.
FALSE. You can also create a part inside of an assembly.

2 Explain top-down and bottom-up assembly techniques.

- The Top-Down assembly technique is used where you create new components while in an assembly
model.

- The Bottom-Up assembly technique uses external files that are referenced into the assembly. The
components that make up the assembly in this approach are created as individual files.

3 True___ False___ An occurrence is a copy of an existing component.
TRUE

4 True___ False___ Only one component can be grounded in an assembly.
FALSE. More than one component can be grounded in an assembly file.

5 True___ False___ Autodesk Inventor does not require components in an assembly to be fully constrained.
TRUE. However underconstraining a component would result in the assembly acting unstable.

6 True___ False___ A sketch must be fully constrained to adapt.
FALSE. You typically underconstrain a sketch allowing it to adapt when placed in an assembly file.

7 What is the purpose of creating a presentation file?

Creating a presentation file will allow you to demonstrate how parts in an assembly interact with each
other. An exploded presentation can be created with an assembly to expose parts that would otherwise be
hidden from view. Animations can be created that show how parts are assembled or disassembled.

8 True___ False___ A presentation file is associated with the assembly file on which it is based.
TRUE

9 True___ False___ When creating drawing views from an assembly, you can create views from multiple presentation
views or design view representations.

TRUE



Chapter 7
CHECKING YOUR SKILLS

1 True___ False You can dimension geometry that uses the construction style.
False, Construction geometry can be constrained and dimensioned like normal geometry, but the
construction geometry will not be seen in the part when the sketch is turned into a feature.

2 True___ False___ Splines cannot have geometric constraints applied between them and other geometry.
False, Constraints can be added to any visible handlebars, curvature arc, or flat of any point on a spline.
The following constraints can be added: concentric, equal, collinear, horizontal, perpendicular, parallel,
tangent, and vertical.

3 True___ False___ Modifications to a shared sketch will update all the features that use that shared
sketch.
True

4 True___ False___ Slice Graphics will permanently slice away a portion of the model.

False, The Slice Graphics option will temporarily slice away the portion of the model that obscures the
plane on which you want to sketch. To restore the sliced graphics, right-click and select Slice Graphics,
select Slice Graphics from the View menu, or click the Sketch or Return button from the Command Bar to
end the sketch.

5 True False____ The Project tool can project vertices, work features, curves, or silhouette edges of
another part in an assembly to the active sketch.
True

6 True___ False___ When creating parameters in a spreadsheet, the data items must be in the following
order: parameter name, value or equations, unit of measurement and, if needed, a comment.
True

7 Explain how to suppress a patterned occurrence.
To suppress a patterned occurrence, move the cursor over an occurrence in the pattern and right-click. A
menu will appear, click Suppress Element(s) and then select the occurrence (s) that will be suppressed.

8 What is the difference between a Model Parameter and a User Parameter?

- Model Parameters are automatically created and assigned a name when a sketch dimensions;
feature parameters such as extrusion distance, draft angle, or coil pitch; and the offset, depth, or
angle value of assembly constraint is created. Autodesk Inventor assigns a default name to each
model parameter as it is created.

- User Parameter are manually created in the Parameter dialog box.

9 What is a reference parameter?

A reference parameter is created automatically when you create a driven dimension. Autodesk Inventor
assigns a default name to each reference parameter as you create it. The default name format is a *‘d’’
followed by an integer incremented for each new parameter. You can rename reference parameters via the
Parameters dialog box.



Chapter 8
CHECKING YOUR SKILLS

1 True___ False___ When creating a single rib or a web feature, only a closed profile can be selected as
the profile.

False, A rib or web feature is defined by an open, unconsumed profile that is then refined using the options
in the Rib dialog box.

2 True False Both the Extrude and Revolve tool can use the minimum or maximum extrusion
solution.
False, The Extrude tool is the only tool that utilizes the minimum or maximum extrusion solution.

3 True___ False___ You can only place embossed text on a planar face.
False, A closed shape or text can be embossed or engraved onto a planar or curved face.

4 True___ False___ A sweep feature requires three unconsumed sketches.
False, A sweep feature requires two unconsumed sketches—a profile, and a path that the profile will
follow.

5 True___ False___ You can create a 3D curve with a combination of both 2D and 3D curves.
True

6 Explain how to create a 3D path using geometry that intersects with a part.
- Create the intersecting features.
- Change to the 3D Sketch environment by clicking the 3D Sketch tool from the Standard toolbar
under the 2D Sketch tool.
- Start the 3D Intersection tool from the 3D Sketch Panel Bar.
- The 3D Intersection Curve dialog box appears.
- Select the two intersecting features.
- Click the OK button and a 3D path will be created.

7 True___ False___ The easiest way to create a helical feature is to create a 3D path and then sweep a
profile along this path.
False, Use the Coil tool.

8 True___ False___ You can control the twisting of profiles in a loft by defining point sets.
True, A point set is used to define how segments blend from one section to the segments of the section
before and after it.

9 Explain how to save both halves of a part after splitting it.
To create a part with the other side removed, edit the split feature and redefine it to keep the other side,
save the other half of the part to its own file using the Save As command.

10 True___ False___ You can copy features between parts using the Copy Feature tool on the Part
Features Panel Bar or toolbar.
False,

- Right-click on a feature's name (in the Browser) that will be copied.
- Click Copy from the menu to copy the feature to the clipboard.
- Start the Paste command by doing one of the following:
o Right-click and select Paste from the menu.
o  Click Paste from the Edit menu.
o From the keyboard, press both the CTRL and V keys at the same time.

11 Explain the difference between suppressing and deleting a feature.
- Suppress, temporarily turn off the display of a feature.
- Delete, permanently removes the feature from the part.



12 True___ False___ After mirroring a feature, the mirrored feature is independent on the parent feature.
If the parent feature changes, the mirrored feature will not reflect this change.

False, The mirrored feature(s) will be dependent on the parent feature—if the parent feature changes, the
resulting mirror feature will also update to reflect the change.

13 Explain why you would want to override a part's mass and volume properties.

While designing, you may not always draw parts that are 100% complete; for example, you may model only
the bounding area and critical features of a purchased part. You still want the mass and volume to be
accurately represented in the Properties dialog box.

14 True___ False___ After changing a part’s physical material properties, the part’s color in the graphics
window will change to match the material.
True, only if the material color is set to As Material.



Chapter 9
CHECKING YOUR SKILLS

1 The base feature of a sheet metal part is most often a:
b). Face

2 What is the procedure to change the edges connected by a bend feature?
¢). Edit the bend and select the new edges.

3 Which tool would you use to create a full-length rectangular face off an existing face edge?
a). Flange

4 What is required to update a flat pattern model?
d). The flat pattern is updated automatically.

5 True___ False___ Sheet metal parts can contain features created with Autodesk Inventor modeling tools.
True

6 True___ False___ Sheet Metal Style settings cannot be overridden; a new Style must be created for
different settings.

False, you can override specific settings of the current Sheet Metal Style on a per feature basis. Some of the
settings that can be overridden are the Unfold Method, Bend Transition, Relief Shape, Relief Width, Relief
Depth, Bend Radius, and Minimum Remnant.

7 True False___ During the creation of a sheet metal face, it can extend to meet another face and
connect to it with a bend.
True



